Subdivision Layout and Design Made Easy
Toby Jutras

CV12-2. For those who have figured out that subdivision design is an iterative process, this session is for you. Imagine if changing a whole design were as easy as a few grip edits ... it is! Come see how to leverage the dynamic object relationships and styles as they apply to the common tasks of subdivision layout and design.

About the Speaker:
Toby is a senior applications engineer with Autodesk, specializing in Civil Engineering Solutions products. Toby regularly presents at seminars and technical workshops. His understanding of the construction, civil engineering, and surveying fields comes from 10 years of experience working on engineering projects in New England. Toby has been the lead designer on a wide array of project types, including highway interchanges, fuel storage facilities, and retail/residential projects.

toby.jutras@autodesk.com
# Table of Contents

SESSION OVERVIEW .................................................................................................................. 4

SESSION DESCRIPTION ............................................................................................................ 4
PRODUCT DESCRIPTION ......................................................................................................... 4
ABOUT THE MERE POINT VILLAGE SUBDIVISION ................................................................. 4

INTRODUCTION ....................................................................................................................... 5

PROJECT STARTING POINT ..................................................................................................... 5

IMPORTING LANDXML ............................................................................................................ 6

SURFACES .................................................................................................................................. 6
  CONTOUR LABELS .................................................................................................................. 7
  ADDING POINTS TO A SURFACE ......................................................................................... 7

SITES IN AUTODESK CIVIL 3D ............................................................................................ 9
  CREATING SITES .................................................................................................................. 9
  CREATING THE PROPERTY PARCEL ................................................................................... 10
  CHANGING THE SITE STYLE ............................................................................................... 11

LAYING THE FIRST ALIGNMENTS ......................................................................................... 11
  ALIGNMENT LAYOUT TOOLS ............................................................................................. 12
  PLACING THE FIRST ALIGNMENT – SEGUIN DRIVE ......................................................... 13
  PLACING THE SECOND ALIGNMENT – JEWELL STREET ................................................. 15
  PLACING THE LAST ALIGNMENT – CHEBEAGUE LANE .................................................... 17

PROFILES .................................................................................................................................. 17
  JEWELL LANE PROFILE ...................................................................................................... 17
  FINE TUNING THE ALIGNMENT DESIGN ...................................................................... 18

RIGHT OF WAY DESIGN ....................................................................................................... 19
  CREATING A RIGHT OF WAY USING THE AUTOCAD FILLET COMMAND ...................... 19
  MANAGING PARCEL STYLES & DISPLAY ORDER ............................................................. 20

PARCEL DESIGN ...................................................................................................................... 21
  CREATING AREAS TO BE SUBDIVIDED ....................................................................... 21
  USING THE ATTACH LOT LINE TOOL .......................................................................... 22
  SIZING PARCELS .............................................................................................................. 22
  CREATING A PARCEL TABLE ............................................................................................ 23
  CREATING A SETBACK ..................................................................................................... 23

CREATING CONSTRUCTION DRAWINGS ............................................................................. 24

CONCLUSION ........................................................................................................................ 24
Session Overview

Session Description
For those who have figured out that subdivision design is an iterative process, this session is for you. Imagine if changing a whole design were as easy as a few grip edits ... it is! Come see how to leverage the dynamic object relationships and styles as they apply to the common tasks of subdivision layout and design.

Product Description
Autodesk® Civil 3D™ 2004 is an all-new civil engineering tool that is available as part of Autodesk® Civil Series 2004 and for Autodesk® Civil Design 2004 customers with subscription. Autodesk Civil 3D 2004 is the only civil engineering tool that creates intelligent relationships between objects so design changes are dynamically reflected. Data is entered once and the software makes changes automatically according to your preset design rules and criteria. The enhanced 3D interaction makes it easy to explore and visualize what-if scenarios and to correct errors on-the-fly. Take civil engineering to the next level with Autodesk® Civil 3D™.

About the Mere Point Village Subdivision
The Mere Point Village project was provided to Autodesk, Inc., courtesy of Sitelines, P.A. of Brunswick, Maine.

SITELINES, P.A. is a Site-Civil Engineering and land planning firm specializing in providing technical assistance to both private and public sector clients throughout Maine.

Founded in 1989, Sitelines P.A.'s primary services of civil engineering and planning focus on productively integrating changes into our natural environment. Their staff is knowledgeable in the laws and policies of state and local agencies regarding site development and environmental protection and is committed to assisting clients in evaluating and implementing successful land management alternatives.

The Mere Point Village project is the first planned neighborhood in a proposed larger master planned development of 317 beautifully forested acres of land in Brunswick, Maine owned by Downeast Energy, Corp., The large master development includes an extensive trail network and other open space and recreational opportunities and is a mile from the Atlantic Ocean.

The Mere Point Village neighborhood includes 33 single-family home lots on a 34.5 acre parcel with over 2,600 linear feet of paved roadway and underground utilities to serve each lot. Some interesting design considerations included very sandy soils in the project area, preserving a pitch pine tree grove to the northwest and a stream to the west that came under the National Resource Protection Agency jurisdiction.

The original project was designed with the Autodesk Civil Series family of products.
Introduction

While subdivision design encompasses many aspects of Surveying and Civil Engineering, this session will focus specifically on the process of developing a conceptual layout of the roads and parcels that make up a subdivision design.

Often an iterative process, developing the layout of roads and parcels has a significant affect on the number of lots, and the desirability of the completed design. Unfortunately, the word iterate by definition means doing things more than once. This doesn’t sound like a promising way to make a profit in a competitive environment where we can’t afford to do any more work than necessary to provide a quality design.

If you take a look at your existing process, where is most of your time spent during these iterations? It likely depends on how much you pursue each of the design alternatives, but largely it is the process of redoing work related to your changes. For instance when you update an alignment, you likely need to generate a new profile in order to see what type of grading would be involved in your road design.

In this session, we will be exploring how Autodesk Civil 3D will change the way you think about iterative design. It’s dynamic relationships between related civil engineering objects, like alignments and profiles, virtually eliminates manual updates as described above, and guarantees that your work remains in sync.

In the pages that follow, we will be reviewing the use of Autodesk Civil 3D in the conceptual phase of subdivision design, exploiting the use of these relationships, and the powerful style driven output that Autodesk Civil 3D has to offer.

Project Starting Point

As we begin our work, several elements will already be included in our drawing:

- AutoCAD 2004 baseplan drawing showing existing features
- AutoCAD 2004 polyline representing the existing parcel to be subdivided
- Aerial photograph
- LandXML file of existing terrain model

Our process will begin by creating a new drawing from a prototype that contains our company’s standards represented in Autodesk Civil 3D by styles.

1. Create a new drawing using the AU Subdivision Design.dwt Template
2. XRef the Existing Baseplan.dwg
3. Import the Parcel.dwg, which represents the existing parcel to be subdivided.
Importing LandXML

In addition to the property and features, the survey firm also created contours, and provided a surface in LandXML format. Providing the data in this format ensures that we can accurately view the surface as it was intended by the surveyor, using it for not only contours, but also for the road profile later in the project.

1. General -> Import LandXML
2. Select the 'Mere Point Village Points & Surface.xml' file from the Mere Point project directory
3. Select Open

In addition to importing LandXML data, Autodesk Civil 3D has the ability to read Autodesk Land Desktop data for points and terrain models.

4. Select OK

Surfaces

Notice that the entire Existing Ground surface is represented as a single object in Autodesk Civil 3D. The display of the surface is controlled by styles in Autodesk® Civil 3D™. This ensures that the design documents representing your company have a consistent and professional look.

5. View -> Viewports -> 2 Viewports
6. Accept the default of vertical
7. In the left viewport, zoom to the stream at the southern end of the site
8. Select a point in the right viewport
9. View -> 3D Views -> SE Isometric
10. Zoom to the same location in the 3D view
11. View -> Shade -> Gouraud Shaded

Simply by changing from a 2D to 3D view, the style of the surface changes its representation. Styles allow you to visualize and interact with your design data in 2D or 3D as desired. This particular surface style shows contours in the plan view on the left and shaded 3D elevation banding in a 3D view on the right. In addition, we can apply styles that control the look of the surface.
Styles in Autodesk Civil 3D can be used to represent your company’s standards, and ensure consistent output in the construction documents that represent your company. We will be using styles throughout the remainder of the application to control the display of other engineering objects as well.

**Contour Labels**

Contour labeling is quick, easy, and dynamic as well.

12. Zoom to a location where you would like to add labels
13. Surfaces -> Labels -> Add Contour Labels
14. Draw a line that crosses several contours
15. Select the line so grips appear
16. Adjust Grips

Contour labels in Autodesk Civil 3D are dynamic as well. As the line changes, any contour that crosses it will be labeled. Label styles provide options on how the text appears, and what interval is labeled.

Once the labels are in their final position, the layer the line appears on can be turned off.

17. Hit the ESC key to clear grips
18. Select the line so grips appear
19. Select the layer _Contour Labels from the layer drop down

**Adding Points to a Surface**

Now, let’s take a look at the relationship between objects by adding the points from our LandXML file to the surface. First, we’ll need to zoom to the points in question.

1. Expand the parent drawing in the Prospector view
2. Expand the Point Groups tree
3. Select the Supplemental Spots Point Group
4. Select the right mouse button
5. Select Zoom To from the right click menu

Commands are most easily accessed by context menus within the Prospector window. The Prospector and Settings tabs in the docked toolspace play an important role in navigating our data, and controlling our style based drafting.

The Prospector view allows us to manage and manipulate all the objects in our project. The Settings tab lets us control how the objects are displayed and annotated. You may find this more
intuitive than navigating pull-down menus, as it is a bit easier to visualize the data and it’s relationships with other objects.

On many projects I’ve worked on, supplemental ground survey data is often needed after design starts. This can be a result of working in an unexpected area, or finding that the detail for a given area isn’t adequate for the type of work planned.

In traditional tools, adding these points to an existing surface would be a multi-step process. In this case, all we need to do is to add these points to the surface definition. The dynamic relationships between the points and the surface will do the remainder of the work for us.

6. Expand the Surfaces tree node
7. Expand the Existing Ground tree node
8. Right click Existing Ground
9. Set the option for rebuild automatic

By setting the rebuild automatic option, any time data the surface is built from changes, the surface will update to reflect that change saving time and ensuring that we are viewing up to date information.

Although you may find this feature incredibly powerful, here are some warnings:
- If you create a surface from contours, use caution not to delete the original contours. If you do, the contours will be removed from your surface and rebuilt.
- When working with data in LandXML files, be sure to place the file in a central location before importing it. If a coworker updates the surface, and can’t find the LandXML surface, that data will not be used in the rebuild.

10. Expand the Definition tree node
11. Right click the Point Groups item
12. Select Add…
13. Select the Supplemental Spot Elevations point group
14. Select OK
Sites in Autodesk Civil 3D

Sites in Autodesk Civil 3D can be described as a container for objects with a common relationship. Alignments, parcels, and gradings can only be created in a site.

For instance, parcels contained within the same site, share a topology so that when a common line between parcels is moved, both dependant parcels are updated. Parcels belonging to different sites have no relationship.

Some common uses for sites are as follows:
- Store soils or wetland information in a site. This allows you to leverage the annotation and analysis features of parcels, without necessarily creating a relationship to your actual parcels.
- Manage the phases of a subdivision using sites. This ensures that as you create new parcels in a new phase, the older already built parcels are unaffected.

Creating Sites

The first step is to define the name of the new site.

1. Select Sites in the Prospector view
2. Click your right mouse button
3. Select New

The Site Properties dialog is displayed with a default name for the site. If you plan on having more than one, you may elect to use a more meaningful name. In this case, I have selected the name Mere Point Phase I as the name.

4. Enter a name: Mere Point Phase I
5. Select OK

The remaining tabs in the Site Properties dialog contain settings that control the default layers for construction geometry and default numbering schemes for new alignments and parcels.
Creating the Property Parcel

Although the site serves as the container for our alignments and parcels, it does not have any geometry associated with it. In order to define the piece of real estate that we will be dealing with on this project, we must define a parcel that represents it. The surveyor on this project provided an AutoCAD drawing of a polyline that represents our site boundaries on this project, and we will convert that into a parcel in Autodesk Civil 3D so we can begin subdividing our property in this project.

1. Zoom Extents

The tan line represents the boundary of our parcel.

2. Parcels ->Create from Objects
3. Select the Property Boundary
4. Select Enter

There is quite a bit going on in this dialog, so a few explanations before we move on. The Site at the top of the dialog box is what we have been referring to in some of the previous writing.

The Parcel Style controls the look of the parcel. We will likely have different styles for our property, right-of-ways, and our individual lots. Having a style for each of these will allow us to differentiate between them by using color, linewidth, or even layer if we choose.

In addition to having a parcel style, we can also define an area style to use. The area label will appear in the centroid of each lot, and may display the parcel number, area, and other relevant information we choose to include.

Finally, we can control the segment label styles. Specifying these styles along with enabling the option to automatically add segment labels will save us quite a bit of time in labeling later.

5. Select the Property parcel style
6. Select OK

As you can see, our parcel boundary was converted to a parcel object, and was automatically annotated with an area label and segment labels.
**Changing the Site Style**

One setting that is easily overlooked is the parcel style assigned to the Site. In general, you want the style assigned to the site to be the same as assigned to your property parcel. Finding this setting can be just a bit tricky.

1. **Highlight the Sites item**

   The lower part of the dialog contains a list of properties about your site. By scrolling to the right, you can see that there is a Style property.

2. **Click on the Style property**

3. **Select the Style ‘Property’ in the Select Style dialog**

   With this step complete the site and property parcel share the same style.

**Laying the First Alignments**

The area of our site to be developed has several geographic limitations that will constrain the phase one portion of our design.

To the west, we have a small ravine, in which a small stream flows. Our site design will not go further west than this feature.

To the east, we have the main road, to which our entrance will be connected to.

To the south, there is another wetland area, and the limits of our property.

To the north, we have some existing recreational paths, and quite a bit more land that could be developed. For our first phase, however, we will constrain ourselves to the area south of the recreational path and within the other constraints described above. The resulting area will afford us an area of about 34-35 acres, and give us enough room for about 30-33 lots.

Since our site will ultimately provide access to at least some subsequent phases, it may be a good idea to first lay in our primary access road, which at one point will be continued. Alignment layout in Autodesk Civil 3D is accomplished with a sophisticated set of tools that
allow you to create constraint based alignments. Here, we will use these tools to create a simple alignment for our access road.

**Alignment Layout Tools**

As we get ready to begin laying out our alignment, it may be a good time to review the tools we have at our disposal.

Autodesk Civil 3D includes a robust set of alignment layout tools. A short summary is in order before getting started with our layout.

The layout tools can be divided into several categories.

**Multi-Tangent Alignment Layout Tools**

These tools facilitate the layout of alignments by providing the ability to sequentially layout tangents, with or without adding curves automatically. If the curve option is used, the properties of the curve are derived from the Curve Settings... option.

When completed, these alignments will show grips at each of the PI locations, and curves will maintain tangency as edits are made. While these tools provide a very quick way of laying out and editing alignments, they don’t expose the advanced constraints found in some of the other tools.

**Fixed Lines**

While there are a couple of ways to layout fixed lines, the principals remain the same. A fixed line uses the grips at it’s endpoints to constrain its length and direction. This can be useful when defining some of the major lines that will define your alignment.

**Floating Lines**

Floating lines maintain tangency to the previous segment they are attached to.

**Free Lines**

Free lines can only be placed between curves. As the curves change, the free line will remain tangent to both curves.

**Fixed Curves**

Much like the fixed lines, fixed curves are defined by the constraints they are created by. There are no tangency rules with the fixed curves
Floating Curves
Floating curves maintain a tangency rule to the previous segment. Some floating options include radius and through point, while the radius and length options can prove valuable for designing larger cul-de-sacs and loop roads, where you want to preserve the loop as the previous elements are moved.

Free Curves
Free curves can be placed between two fixed entities, and their only constraints are the radius, or pass through point.

Placing the First Alignment – Seguin Drive
Our road should start opposite another road in the northern portion of our site. We will try to follow the existing recreational path as much as possible, projecting beyond the phase one bounds. Later in the design process, we will design an alignment to go in a southerly direction from the pitch pine area.

1. Alignments -> Create by Layout
2. Enter a name for the alignment of Seguin Drive
3. Select the alignment style Local Road
4. Select the alignment label set All Labels
5. Select OK
With the name and style of the new alignment established, we can begin to use the layout tools to create our road alignment. Our first segment of road will be 100’ long, and parallel to the entrance opposite our new one.

6. Select the icon to begin creating a fixed tangent
7. Use the endpoint object snap to set the beginning of the alignment at the intersection with the existing street
8. Use the extension object snap to make the new road parallel to the one opposite
9. Enter a length of 100’ using direct distance entry

Even with all of our powerful selection tools, object snaps in AutoCAD still play a big part in the geometric design of our new alignments. With our tangent in place, the next step is to create a set of reverse curves to create some interest in the entrance.

10. Use the to begin creating a floating curve that holds the radius and length
11. Direction is counter clockwise
12. Radius is 300’
13. Length is 200’

The next step in our alignment design is to add the final curve in our reverse curve drive. The curve will extend well beyond the limits of this first phase, and be continued in a subsequent phase.

14. Select the same tool to begin creating another floating curve using the radius and length as constraints
15. Select the end of the alignment
16. Direction is clockwise
17. Radius is 400’
18. Length is 200’
The above steps created the desired affect, however the second curve is not quite long enough to project beyond the limits of our project, and should be extended to a length of 800’. This can be easily done by selecting the Alignment Grid View, which shows a Panorama window with the alignment Vista.

19. Select the icon from the Alignment Layout Tools toolbar
20. Change the length of the second curve to 800’
21. Select the X to exit the Panorama
22. Right click your mouse to exit the alignment creation toolbar/prompt.

Our first alignment was created easily. Notice individual constraints and the overall relationship between the alignment segments. As components are modified, their dependants are automatically updated.

You probably also noticed that labeling was integral to our alignment object. An alignment style, and label style were provided at the very beginning of this process, when the alignment was named. These styles can be changed after the fact by editing their properties.

**Placing the Second Alignment – Jewell Street**

We will use a slightly different technique on the second alignment. We are simply going to free hand a section consisting of 3 tangents, and then append a loop to it. This will give us the flexibility to try several locations before committing to a specific location.

1. Alignments -> Create by Layout
2. Set the Alignment Style to Local Road
3. Set the Alignment Label Set to All Labels
4. Give the alignment a name of Jewell Street
5. Select OK
To begin roughing in the location of the alignment, we will make use of the Tangent-Tangent tool with curves. The default curve radius is set for 200 feet, so we won’t have to change it.

6. Select the from the Alignment Layout toolbar
7. Using the nearest osnap, select a point near station 6+50 on Seguin Drive as our starting point
8. Select 3 PI locations similar to the graphic shown to the right

The next step in the design of this alignment is to create a series of reverse curves to build a loop in the road. During the layout process, we shouldn’t be too concerned about getting it right the first time, as we can edit individual segments, and delete them if necessary.

9. Select the Floating Curve, radius and length option
10. Counter clockwise
11. Radius of 750
12. Length of 200
13. Clockwise
14. Radius of 750
15. Length of 350
16. Counter clockwise
17. Radius of 125
18. Length of 450
19. Clockwise
20. Radius of 750
21. Length of 250
22. Counter clockwise
23. Radius of 150
24. Length of 275

Lastly, we need to add the final tangent that will tie back in to the alignment, giving us our loop effect. The easiest way to do this is to create a segment that is too long, and then edit it graphically after it is in place.

25. Select the Floating Line
26. Specify a length that is longer than needed
27. Exit the Alignment command
28. Use grips to edit the endpoint to be at the intersection points where the alignments cross
Placing the Last Alignment – Chebeague Lane

The final alignment in this project is a short road with a cul-de-sac on the east side of Jewell Lane. This will give us the frontage required to subdivide the larger width area on the east. Feel free to use any combination of the tools discussed so far to create this alignment on your own.

Profiles

In order to better assess the current design, it may be necessary to create a profile of one or more of the roads before completing the design based on the current layout. For the purpose of this example, we will only take the time to review the profile for Jewell Lane.

Jewell Lane Profile

Creating a profile in Autodesk Civil 3D is a very easy process.

1. Profiles -> Create from Surface
2. Select the Alignment Jewell Street
3. Select the Surface Existing Ground
4. Select the Add>> button
5. Select the Draw in Profile View button
While the profile can be described as the actual line that represents the section through the earth along the alignment, the Profile View is a container that can host multiple profiles. For instance existing ground and finished ground might be different profiles shown in the same profile view.

The Create Profile View dialog box allows us to name the profile view for future reference. It also gives us an opportunity to select the style for the Profile View, as well as the band set that will be used to display data about the alignment or profile.

6. Select OK  
7. Select a location for the profile

---

**Fine Tuning the Alignment Design**

Many times there is a vertical element to the horizontal alignment layout. In some cases, alignments are constructed around obstacles such as bedrock, hills, and other features that would increase the cost of the project.

8. View -> Viewports -> 2 Viewports  
9. Select the Horizontal option  
10. Zoom to the profile in the top viewport  
11. Zoom to the plan in the bottom viewport

*Note: You may elect to use AutoCAD’s DView command to orient the plan view to be orthogonal to the screen*

To make minor changes, we can simply grip edit the alignment. You should watch for two things as you do this:

- The annotation will follow the alignment, and values will update
- The profile will update after each edit to reflect the new path of the alignment
This dynamic relationship between the alignment and profile eliminates the need to manually redefine the alignment, re-annotate, and recreate the profile. Each successive revision will only amplify the power of this relationship.

**Right of Way Design**

Everything we’ve done in the preceding steps has Autodesk Civil 3D’s dynamic relationships between objects. Up to this point, any change made to our surface or alignment would be reflected by our profile. Right-of-way design is one of the few areas of the product where a dynamic relationship does not yet exist. Ideally, as we change our alignments, the corresponding alignment would update.

Until a dynamic ROW object is created in Autodesk Civil 3D, we have two options:
- Create a static ROW using the Create ROW tool in the parcels pull down
- Use the AutoCAD offset command to offset the alignments by the ½ the ROW width

**Creating a Right of Way Using the AutoCAD Offset Command**

While the Create ROW tool does provide a quick and easy way to create right of way lines based on the alignment, using the AutoCAD offset command yields more flexibility. By using the offset command, you can achieve a different offset for different types of roads, use different radius at street intersections, and finally build cul-de-sacs using normal construction techniques.

1. Modify -> Offset
2. Enter an offset distance (25 for a 50’ ROW)
3. Select an alignment
4. Select a point to one side of the alignment
5. Repeat steps 3-4 for the other side of the ROW
6. Repeat as necessary

The process is straightforward, and should only take a few minutes. You can take the time to clean up intersections by trimming and filleting the intersecting ROW lines using the desired radius. Cul-de-sacs can be easily drawn by creating a circle at the end of an alignment, and cleaning up intersections as described above.

Once completed, the resulting lines/polylines can easily be converted to parcel objects.

7. Parcels -> Create from Objects
8. Select the Parcel Style of Road (or similar)
9. Select OK
Managing Parcel Styles & Display Order

A parcel line can represent the common boundary between dissimilar parcels. For instance, the right of way that was just created in the preceding steps is the boundary between the property parcel, and the road parcel. This common line can be perceived as either style, so how do we control which style is used?

The tool that allows us to control this display order can be most easily found by viewing the properties for the parcels.

10. Expand the Sites tree item in Prospector
11. Expand the site name in Prospector
12. Select Parcels
13. Select the right mouse button
14. Select Properties…

The Parcel Style Display Order list shows each parcel style that is represented in the current drawing. You can select any of the parcel styles in the list, and use the up/down buttons to the right to change the display order.

In this example, we would like the ROW lines shown with the parcel style Road (local) to be displayed at a higher priority than Property. The results will be that the common line between them will be shown with the Road style.
Parcel Design

In order to be profitable, our developer needs to create ~30 parcels in this first stage of development. To accomplish that, several parcels will be created to the north of the access road, and the remaining parcels will be distributed to the east and west of Jewell Street. The existing stream to the west will serve as a back line for the parcels on the west side of the street.

In order to accomplish the goals above, a number of different parcel layout tools will be employed. The tools bear much similarity to those used for alignment design.

Creating Areas to be Subdivided

The first step in creating our parcels will be to create an enclosed area to be subdivided. The first place we will do this is on the north side of the entrance road.

1. Parcels -> Create by Layout
2. Select the (draw tangent-tangent with no curves)
3. Select OK

To save time, we can elect to turn on the option for automatically adding segment labels. If you forget to add them, they can be added later very easily.

As new closed areas are defined, notice that Autodesk Civil 3D automatically appends a new parcel definition in Prospector, as well as labels the new area with a Parcel Label, which can include area/perimeter and other information.

We have just a few more lines to place before we can begin using the tool that allows us to design lots. This is a fairly subjective process, but the goal is to follow steps 1-3 above, creating more closed areas.
Using the Attach Lot Line Tool

Once major areas are defined, they can be more easily parcelled out into lots using the Attach Lot Line tool. This is the only way to create parcels that can be modified using the sizing tools. This tool also places lot lines perpendicular to the adjacent parcel line (ROW for instance), and maintains that relationship with only a single grip appearing on the object.

4. Select the lot line tool

Notice that as you move your cursor over the area to be subdivided, the new lot line moves freely.

5. Click to select the location of the new lot line

Instead of specifying a direction, you can simply select the enter button to keep the new lot

6. Select Enter

Sizing Parcels

Once the lots have been placed, they can be appropriately sized. In our case, we would like to evenly distribute the property into 4 roughly equally sized lots. In our case, the lots should be about 32,000 sf each.

7. Parcels -> Edit
8. Select the Slide Bearing method of sizing
9. Select the line to be changed
10. Select a point in the parcel to be sized
11. Specify a size, or pick a point
12. Specify the range to search for the solution (if prompted)
13. Repeat 8-12 as necessary
Creating a Parcel Table

Often times, we would like to have a parcel table that demonstrates areas of each parcel. There are many strategies that can be employed to create tables that are dynamic, on multiple levels. Not only can we make a table change with changes to the parcel, but we can ensure that new parcels that are added to the project are also added to the table.

14. Parcels -> Tables -> Add Area
15. Select the Area Only style (or one of your choosing)
16. Use the selection rule Add Existing and New
17. Toggle Apply for the label style name that represents the label styles being used in this project
18. Select OK
19. Select a location for the table

Creating a Setback

While there is no setback object, you can easily create setbacks using the AutoCAD offset command.

20. Create a new layer in AutoCAD called Setback, and set it current
21. Modify -> Offset
22. Enter an offset value appropriate for your parcel
23. Select the parcel label
24. Select a point inside the parcel

If you have different front, back, and side setbacks, you can also just offset each of the individual segments.
Creating Construction Drawings

Finally, let’s take a look at completing a construction drawing with Autodesk® Civil 3D™. With traditional tools, there were several obstacles in preparing a set of construction drawings:

- Not all drawings shared the same north direction
- Some areas of plan are to be shown in different scales
- Some of this text is stored in external references

Autodesk Civil 3D makes managing text much easier. Text sizes are represented using paper space (layout) units. Regardless of what scale your viewport is set to, the text will maintain this paper space size. After changing the scale of a viewport, simply use the Regen All command in AutoCAD to refresh text heights.

Additionally, labels can be made view orientation aware. This means that our parcel labels will remain readable, even on sheets where we use DView to twist the plan direction of the sheet.

Lastly, both of the features described above work through external references with no special effort required.

Conclusion

While not yet a complete replacement for the Autodesk Land Desktop and Autodesk Civil Design packages, Autodesk Civil 3D provides a tremendous value to engineering firms in the conceptual phases of design. In this last exercise, we were only able to discuss a handful of features that make the engineering process more efficient, such as:

- Dynamic relationship between related engineering elements
- Dynamic relationship between engineering objects, and their annotation
- Style driven drafting that is derived from the engineering
- Flexible labels that adjust themselves to varying scales and rotations

This dynamic behavior replaces a significant percentage of project time that is typically devoted to drafting. Since these issues no longer require manual intervention, that time can be more effectively used during the engineering process. In addition, because of the dynamic relationships, making design changes and corrections no longer has the same costly impact on time for maintaining the synchronization between related elements and their labels.

Toby Jutras
Applications Engineer

Autodesk, Inc.
100 Commercial Street
Manchester, NH 03101
USA